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1.1 Package Contents

e D-Link DWR-720P WCDMA / 3G Fixed FLLA Phone
e Battery

e Handset Cord

e Handset Receiver

e Antenna

e Power Supply

Note: Using a power supply with a different voltage rating than the one included with the DWR-720P will cause damage

and void the warranty for this product.

1.2 System Requirements

A compatible (U)SIM card with service!

'Subject to services and service terms available from your carrier.

Version 1.00 |2018/06/25
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1.3 Safety and Maintenance

1.3.1 Using the Phone

Please observe the following points:

e Before use, please read the instruction manual carefully.

e Do not power on the phone when the use of a cellular phone is prohibited as it may cause interruptions or danger.

e Please keep your phone switched off when you are on a plane. If functions that will automatically power on your phone, such as alarm
clock or calendar, are setup, please check and cancel the configuration before boarding the plane.

e While using the phone, please keep away from heat source and high voltage environments, such as electric appliances or electric
cooking devices. Please use the phone under normal operating temperatures.

e Do not operate the phone whilst driving.

e Only the original supplied battery, charger and accessories should be used.

e Phone may cause interference to nearby electronic devices, therefore keep it away from electronic devices such as radios, PC’s,
pacemakers, hearing aids, etc. Do not place the phone near credit cards or any magnetic fields.

e Do not disassemble the phone — Any unauthorized work performed on the phone will void the warranty.

e Do not use benzene, thinners, alcohol, or corrosive chemicals such as detergent to clean the cover of your phone.

e Your phone is not water-proof, so please keep it dry. Do not use it in damp environment, such as a bathroom. Keep it away from rain and

moisture.
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1.3.2 Using the Battery

Please observe the following points:

e Before use, please read instructions for use as well as label on the surface of the battery.

e Please charge the battery in a cool and well-ventilated room as high temperatures may lead to overheating.

¢ Do not attempt open the battery as it may lead to short circuit or electrolyte leakage.

e |If electrolytes get in contact with your eyes, there is danger of blindness.

e In such case, immediately wash your eyes with clean water and seek medical attention immediately (Do not rub your eyes)

e Keep the battery away from mechanical vibration and shaking. Do not short connect the battery as this may damage the battery and
components connected to it.

¢ Keep the metal contact points and battery clean.

¢ Do not use damaged or depleted batteries.

e The battery should be replaced when it cannot meet the requirement for performance. Battery can be charged hundreds of times before
it should be replaced.

e Though it can be charged hundreds of times, its quantity of electric charge may decrease gradually. When service time (talk time and
standby time) is found to have decreased, the battery needs to be replaced.

e Prevent the battery from exposure to the skin or places with excessive smoke or dust. Do not use it in damp environments, such as a
bathroom. The battery is not waterproof; so keep it away from rain and moisture.

e Do not put the battery in places that are too hot or too cold. Temperature above 55 degrees Celsius or below -10 degrees Celsius may

affect performance of the battery.
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e Do not put the battery in an open fire as this could lead to an explosion.

¢ Do not put the battery in water to avoid short circuit inside, resulting in battery overheat, smoking, distortion, damage or even explosion.
e Treat battery according to local regulations (for example, recycling). Do not treat battery as domestic garbage.

e Only the original charger supplied with the phone should be used for charging the battery.

e Keep battery out of reach of children to avoid danger.

e Using another type of battery, charger or generic accessories may violate the certification or warranty terms of equipment and may result

in damage.

1.3.3 Using the Battery Charger

Please observe the following points:

e Before use, please read the user instructions as well as the label on the surface of the charger.

e Do not disassemble or modify the charger or use it when power cable is damaged.

e Do not touch the charger with wet hands. If the charger connects with water or other liquid, immediately cut off the power supply.
e Do not short connect the charger and keep it away from mechanical vibration or shaking and direct sun shine.

e Do not use it in damp environments, such as a bathroom.

e The battery charger is not waterproof; therefore keep it away from rain and moisture.

e Keep the charger out of reach of children to avoid danger.
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2.1.1 Front

2 Hardware Overview

iInsert SIM
sUULE =1V =08 (005

Menu Contadtgll
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2.1.2 Back
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2.1.3 Key Descriptions

© Left Soft key
@ Direction key
©Right Soft key
6M1 -M4 QUiCk
Dial keys

G End Call/
On/Off key

®Hands Free Loud
Speaker key

©Keypad

@ Answer key
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1 Left Soft Key Press to go into the main menu in idle screen; Select/Ok in submenus

2 Direction Key
Up Key Scroll through the menu; Default shortcut to Contact List in idle screen
Down Key Scroll through the menu; Default shortcut to Call Logs in idle screen
Left Key Default shortcut to Messaging in idle screen
Right Key Default shortcut to Profiles in idle screen
Right Soft Key In any menu you can go back to the last menu

4 Shortcut Dial Keys Set M1 - M4 as quick dial contacts

5 End Call/ Hold down for a few seconds to power on/off the phone; Press the end key to end
Power On/Off Key phone call or return back to idle screen

6 SMS Key Shortcut access to SMS menu in idle screen

7 Redial Key Press to call the last dialled phone number

8 Hands Free key Press to activate or deactivate hands free/ speaker mode

9 Numeric Keypad To enter numbers and characters

13
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10 | Answer Key Enter the phone number and press Dial key; Press to see last dialled numbers

11 | Star Key In idle screen, press to enter either ><, +, P or W; Press to enter the special
symbol mode, i.e.?!:;., #% % etc.

12 | Hash Key In idle screen, press to enter #; In message editing screen, press to switch input
method, i.e. Abc, ABC, abc, 123.
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2.1.4 Status Icons

Icons on the screen:

Signal strength indicator

3G Network Service available

206
||||

2G Network Service available

No Network Service available

Network Roaming

AC adapter Plugged in and Powered

Battery Life Indicator

Phone set to Silent Mode

Missed Call

New Message Received

O ) S E 475

Alarm has been set

15
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2.1.5 Screen Background Light

e Background light illuminates the screen.

e When you power on your phone, the background light will turn on for a predefined period.

e If no key is pressed within the period, the background light will turn off automatically to save battery life.

To adjust background light brightness and period:

e For Time (sec): [Menu] = [Settings] = [2.Display] - [2.Backlight].
You can now select between: Always on, 30, 20, 15, 10, 5 secs
e For Brightness: [Menu] = [Settings] = [2.Display] - [3.Contrast].

You can now press the left or right arrow keys to adjust the brightness down or up.

2.1.6 Adjust the Volume

During a call:

e Press [Up Key] to increase the volume of the handset or hands free (HF)

e Press [Down Key] to decrease the volume of the handset or hands free (HF)

16
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Before using the phone, make sure the plug or battery is correctly connected and the SIM card has been inserted

2.2 Instructions before Use

correctly. Follow the instructions below on how to install the phone:

01

Flip the phone
around and
open the Battery
Cover at the
bottom of the
device.

02

Insert and slide
the SIM Card
into place as
shown above.

03

Insert the Battery
with the metal end

on the bottom left.

Close the Battery
Cover.

04

Screw the antenna
intothe TNC
Antenna Port

17
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05

Plug the short

end of the hand-
set cord into the
handset receiver

06

Plug the long
end of the hand-
set cord into the
headset port on
the back of the
routerand clip
the cord into the
cable clip.

07

Connectthe AC
Power Adapter
to the socket on
the left side of
the phone.

Plug the power
adapter intoa
wall outlet.

08

On the front of
the device, hold
the Red End call/
Power key for 3
seconds.

The screen will

display a welcome
message to indicate

that the phone is
starting up.

Warning: Before pulling out the SIM card, the phone should be powered off. Inserting or pulling out SIM cards is not

permitted when the external power is connected as it can damage the SIM card.

18
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2.2.1 Power on

e The device can work on both single battery mode and single charger mode.
e Press and hold [Power Key] button until boot screen appears.

e If there is a prompt for PIN code, please enter your PIN code and press [OK] key.

Note: Please contact your service provider for the default SIM PIN code if unavailable.

e After power on, if the SIM card inserted is valid, your phone will automatically search available network.

e |If the SIM card is invalid or inactive, it will prompt you to Insert SIM or indicate Invalid SIM.

2.2.2 Power off

e To power off, press and hold the [Power key] until power off screen appears.
Note: In this state, all reminders and alarms will still sound if set. Power off the phone and disconnect the external power whenever

inserting the battery or SIM card.

2.2.3 Phone Security

You can set an access password to avoid unauthorized use of your phone.
The default phone password is 1234.

To activate or deactivate this feature, please follow these steps:

19
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e In the idle screen > [Menu] - [Settings] = [4.Security] > [Power-on password].
e You now have the option to Activate, Modify or switch Off the Phone Lock feature.

e In order to Activate, Modify or switch Off, you will be required to enter the phone password.

Note: It is highly recommended to change the default password to a 4-8 digit code only you will know

and remember.

To change the phone password, please follow these steps:

e Inthe idle screen - [Menu] = [Settings] = [4.Security] > [Power-on password] = [2.Modify].
e You will be required to enter the current password before you can create a new one.

e [Please input password] = [OK] = [Input new password] - [OK] - [Confirm new password] = [OK].

2.2.4 PIN code

e PIN code is used to prevent illegal use of user’s SIM card.

e If your phone has enabled PIN code protection, you will be prompted to enter your PIN code.

e |f the wrong PIN code is entered three times consecutively the SIM card will be automatically soft locked.
e You will be required to enter the PUK code to unlock it.

e The PIN code is related to SIM card, not the telephone and is provided by your Network Service Provider.

20



D-Link

Building Networks for People

2.2.5 PUK code

e PUK code, referring to Personal Unlock Code, is used to unlock a SIM card that is locked because of wrong input of PIN code.
e |If the PUK code entry attempts exceed ten times, the SIM card will be hard locked and a SIM replacement will be required.

e PUK codes or Replacement SIM cards are provided by your Network Service Provider.

2.3 Basic Functions

2.3.1 Direct dial

Making a phone call:

e In standby state, press the numerical key to enter the phone number and then press [OK key] or the [Dial key] to initiate the call.

e Press [Right soft key] to delete the last digit or long press it to clear all should you have entered the number incorrectly.

e Pick up the handset or press [Hands Free] for the dialling tone.

e |If the phone number being dialled out is recognized by the phonebook, the name of contact person will be displayed on the dialling
screen as well as calling animation.

e Press the [End Call/Power key] to end a call.

21
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Quick dial from contacts list

e In standby state, press the [Right soft key] to enter the phonebook.
e Scroll down to select a contact.

e Press the [Dial key] to initiate the call.

2.3.2 Quick dial from dialled list

¢ In standby state, press [Dial key] to enter [Dialled calls] list.
e Scroll down to the desired contact or the number you want to dial.

e Press [Dial key] again to initiate the call.

2.3.3 Receive a call

e When there is an incoming call, call animation will be displayed together with a ringtone (unless the phone is set to silent mode).
e Press the [dial key] or pick up the handset or Press the [Hands Free] to answer calls.

e Press the [power key] to reject the incoming call.

e If phone number of the caller is not hidden, the number will be displayed on incoming call screen.

e |If the contact information of the caller is stored in contacts, then the caller’'s name will be displayed.

e If the caller id is hidden or the network bans call indication, the incoming call is displayed as s> or Private or Unknown.

22
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2.3.4 Terminate call

¢ When there is an incoming call, press the [Power key] to reject the call.
e During the call, press the [Power key] to terminate current call. Or hang up the handset to end the current call.
e If hands free calling, press the [Hands Free] key to end the current call.

¢ A number that has just been dialled can be cancelled by pressing [Power key].

2.3.5 Make Emergency call

e As long as you are within coverage of network, you can make an emergency call even if you have not registered to local network or do
not have SIM card.

e Enter local emergency number (112) and then press [Dial key] to make an emergency call.

2.3.6 Make International long-distance call

e Press the [*] key until “+” sign appears before international phone number can be dialled. “+” sign tells the network you are making an
international call.
e Enter the country code, area code (without the 0) and phone number

e Press [Dial key] to initiate the call.

Note: Some networks do not allow “+” for dialling international numbers.

23
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2.4 Talk Options

The phone provides some talk control functions during an active call.

During the call, press [Left soft key] to enter [Menu] to access the talk control functions.

2.4.1 Hold / Release talk state

e If network supports, you can hold current call.
e During the call, press [Left soft key - Menu] and select [Hold].

e To activate held call, Press [Left soft key - Menu] and select [Unhold].

2.4.2 Dial second number

e During an active call you can dial another number
e Directly enter the second number and press [Dial key] to call
e Or press [Left soft key - Menu] = [Add new call], enter the number and press [Dial key] to call.

e When the second call is connecting, the first call will be automatically put on hold.
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2.4.3 Answer second incoming call

e Please make sure the network supports call waiting function and the status has been set to Enabled.

e To Enable Call Waiting, in idle screen, [Menu] = [Settings] = [3.Call settings] - [4.Call waiting] = [Activate].

e If there is a second incoming call during talk, you’ll hear a “Beep” tone and the screen will prompt you of the incoming call.

e Press [Left soft key] and select [Hold & answer] to put the first call on hold. Or select [Release & answer] to terminate the first call.
e Press [Power key] or [Right soft key] to terminate the second call.

e If the first call was put on hold, you will need to press [Left soft key] and [Unhold] to activate the first call.

2.4.4 Selecting current phone number

When the second call is answered, press [Left soft key] to enter [Menu]:

1. Add new call: Make a second call and place the first call on hold.

Hold: Place the current call on hold.

Mute: You can now hear your caller but your caller cannot hear you.

Adjust volume: Adjust the volume of the handset, press right for louder and left for softer.
Contacts: Access the phonebook.

Call logs: Access the call logs menu.

N o O R~ N

Messaging: Access the messaging menu.

25
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When the second call is answered, press [Left soft key] to enter [Menu]:

1. Merge calls: Merge first and second call into one call.

Swap: Hold current call and activate the held call

Mute: You can now hear your caller but your caller cannot hear you.

Adjust volume: Adjust the volume of the handset, press right for louder and left for softer.
Contacts: Access the phonebook.

Call logs: Access the call logs menu.

Messaging: Access the messaging menu.

© N o O &~ 0N

End all calls: Terminate both calls

Note: Not all networks service providers offer all the above mentioned services Menu Functions

You can press the [Left soft key] in standby state to enter menu. Press [Right soft key] or [Power key] to return to

standby mode.

26



D-Link

Building Networks for People

3 Messaging

In standby state, select [Menu] - [Messaging].

Or alternatively you can simply press the quick access messages key [SMS]

3.1 Write Message

e Select [Write message] > compose message - select [Options] - Send - [Enter number] or press [Options/Contacts] to add from

contacts - [Options/Send].

e When selecting from [Contacts] - Mark the contacts you wish to send the messages to > [Options/OK] - [Options/Send]

When editing SMS, press the [Left soft key] to enter [Options] menu to access the following options:

1. Send: Send the message.

2.
. Add contact info: Insert the Name and Number of a contact into the message.

3
4.
5
6

Insert template: Insert the preconfigured template into the message.

Add phiz: Insert a text smileys into the message.

. Save as draft: Save your current message to Drafts, which can be access later from the Drafts box.

. Exit: Quit and discard current message.

Note: You must have a positive airtime balance and an active service to use this feature.

27
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3.2 Inbox

The SMS and MMS you received are all stored in the [Inbox].
Open a SMS or MMS and press [Left soft key] to enter [Options] menu.

Available Options:

View, Reply, Delete, Delete all, Voice call, Mark.

You can delete multiple selected messages by selecting [Mark]—>[Mark] then [Options]—>[Delete]

[View] = [Options]:

. Delete: Delete current message.

Reply: Reply to the sender of the message
Forward: Enter into write message mode, you can edit the message per 3.1 Write Message
Voice call: Phone the sender of the message

Add sender to: Add the sender number to new contacts or add to existing contact

3.3 Outbox

Failed SMS and MMS will be saved to [Outbox].

28
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3.4 Drafts

You can choose to send the draft by [Options] = [Edit] 2 [Options] = [Send].

Messages are auto saved to drafts:

e Sudden exit during text editing.

e Save as drafts during write message.

3.5 Sent Box

e SMS and MMS which have been sent successfully is saved to [Sentbox].

3.6 Templates

e Under this option, you will be able to select from pre-loaded message templates, edit them or remove and create your own.

3.7 SMS settings

e Settings for Message centre, Message validity period, Status report, Preferred storage

1. Text centre: By default, this should be set to +2781191

29
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2. Message validity period: Set how long your message is stored temporarily in the SMS centre if the recipient mobile phone is offline.
Validity period can be saved for 1, 6, 24, 72 hours, 1 week, Maximum.
3. Status report: Check/uncheck for a report on whether an SMS message has reached the recipient mobile phone successfully.

4. Preferred storage: Select where you would like to store your messages. SIM or Phone.

3.8 Message capacity

e Under this option, you can check how much space is still left on each storage

e You can store up to 100 messages on the phone and 20 messages on the SIM

3.9 Voice mail server

e Here you can setup the voice mail server for: Line, Fax, or Data number.
e To set up voicemail for your line, dial 181 (free call for Telkom user) and follow the voice prompts.

e You'll get an SMS telling you that you have a new message.

Note: Not all networks service providers offer all the above mentioned services Menu Functions

30
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4 Contacts

In idle screen, select [Menu] - [Contacts]

1. View contact: View all contacts.

2. New: Add New Contacts. Select the desired storage location (Phone/SIM) for your new contact, you have the following fields available to
personalise the new entry: Name and Number. Once all desired field have been updated, select [Options] > [Save] 2 [OK].

3. Search: You can search for the contact by name or number.

4. Speed dial settings: Set up speed dial from Contacts then dial the contact by pressing and holding down the corresponding numeric key
in idle screen. Select the number position of where you wish to set speed dial and press [Options] - [Edit]. Input the number or select
from the Contacts List - [OK].

5. Own number: Save your personal number on the device.

6. Memory status: View memory status.

e Should you need to edit a contact saved, you can [View contact] - [Options] = [Details] = [Options] = [Edit] = [Modify] = [Save].
e You can also Delete, Copy the saved contact the same way

e Delete: [View contact] > [Options] = [Details] > [Options] = [Delete]

e Copy: [View contact] - [Options] - [Details] = [Options] = [Copy] = Select desired location.
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5 Call logs

In idle screen, select [Menu] - [Call logs]

Missed Calls: Press [OK] to view history of calls missed.

Dialled Calls: Press [OK] to view history of calls dialled.

Received Calls: Press [OK] to view history of calls received.

Delete all: Press [OK] to delete all history of calls made, received, and missed.

Call timers: Press [OK] to view call times of last call, total received calls, total dialled calls and call history.

In the missed, dialled, received calls interface, press [Left soft key] to access the [Options] menu.

Details: View the call duration of the selected number.

Call: Press to call back to the selected number.

Write message: Press to send text message to the selected number.
Add to contacts: Add the selected number to new or existing contact
Delete: Delete the selected number from the calls interface

Delete all: Delete all numbers from the calls interface

In the call timers interface, press [Left soft key] to reset timer back to zero.

32
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6 Settings

In standby state, enter [Menu] - [Settings] menu. Herewith the various settings available:

6.1 Phone Settings

6.1.1 Date & time

Set time: Set the time of your phone.

Set date: Set the date of your phone.

Time format: Select from 12 hours or 24 hours format.

Date format: Select from [Year-Mon-Day] or [Mon-Day-Year] or [Day-Mon-Year]

Update time settings: Set your time to [Auto update time] or [Manual update time]
6.1.2 Language setting

Set the preferred display language.
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6.1.3 Input method settings

Choose the preferred input method for the editor by selecting from:

z/zh, c/ch, s/sh, h/f, I/n, in/fing, en/eng, an/ang, ian/iang, uan/uang.

6.1.4 Shortcut settings

You can set the shortcut key for [Up key], [Down key], [Left key], [Right key], [Right soft key]

e Once at the selected key, press left or right to scroll through the options
e Or press [Select] to choose from the list, press [OK] once confirmed.

e Press [Done] when you are done with the shortcut settings.

6.1.5 Shortcut dial settings

You can set the M1-M4 quick dial keys by:

e Select the M# and press [Options] = [1.Edit] = Input number or select from [Contacts] 2 [OK]
e To view an existing quick dial key, press [Options] - [1.View] - Back

e To edit an existing quick dial key, press [Options] = [2.Edit]

e To call an existing quick dial key, press [Options] - [3.Call]

e To delete the selected quick dial key setting, press [Options] = [4.Delete]
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6.1.6 Auto power on/off

Set specific times to automatically power on or power off your device.

e To enable/disable auto power on, select [Auto power on] - [Options] = [1.0n/off]
e To edit auto power on, select [Auto power on] - [Options] - [2.Edit] > Set the time to power on > [OK]
e To enable/disable auto power off, select [Auto power off] > [Options] = [1.0n/off]
e To edit auto power off, select [Auto power off] > [Options] - [2.Edit] > Set the time to power on - [OK]

6.1.7 Power management

Displays the current method of which the phone is powered.

If the phone is powered with the battery, it will display the percentage of power left.

6.1.8 Restore factory settings

Enter the password then the phone will restore back to factory settings. The default password is 1234.
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6.2 Display

Under display you have the following options to select from:

e Display settings: Select whether you’d like the idle screen to show the [Time & date] and [SIM selection]
e Backlight: You have the option to change the time which the LED would stay lit up. Set between 5/10/15/20/30 secs or Always on.
e Contrast: You can adjust the brightness level of the text. Press [Left] to lighten and [Right] to darken the display text.

6.3 Call settings

Note: This function requests network support. Please contact your operator for further details on whether the service

is supported on the network.

6.3.1 Network selection

You can set the network search method to [Auto] or [Manual].
If set to [Manual], you have the option to manually select from a list of networks listed in your area.

Select the network appropriate to your service provider.
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6.3.2 Network type

You can set your preferred network type: WCDMA preferred, Prefer GSM, GSM, and WCDMA.

6.3.3 Call divert

Divert the incoming calls to another phone number.

1. Call forwarding unconditional: This setting redirects all incoming calls to another phone number. Press [Activate] to enable this function.

You can choose between [Divert to voicemail] or [Divert to number].

If [Divert to voicemail] is selected, make sure the correct settings are configured per the SIM card’s service provider under [Line number].
If [Divert to number] is selected, enter the number which you wish to divert the call to, or press [Contacts] to select from an existing
number.

To deactivate this function, press [Off].

You can check if this function has been turned on/off by pressing [Check status].

2. Call forwarding on busy: This setting redirects all incoming calls to another phone number if the phone line is busy. Phone line can be

busy if the number is calling out, you’re not in a service area or you’re using Call Waiting and already have two callers on the line.

Press [Activate] to enable this function. You can choose between [Divert to voicemail] or [Divert to number].

If [Divert to voicemail] is selected, make sure the correct settings are configured per the SIM card’s service provider under [Line number].
If [Divert to number] is selected, enter the number which you wish to divert the call to, or press [Contacts] to select from an existing

number.
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To deactivate this function, press [Off].
You can check if this function has been turned on/off by pressing [Check status].

3. Call forwarding on no reply: This setting redirects all incoming calls to another phone number if the call isn’t answered within a specified

number of rings. Press [Activate] to enable this function. You can choose between [Divert to voicemail] or [Divert to number].

If [Divert to voicemail] is selected, make sure the correct settings are configured per the SIM card’s service provider under [Line number].
If [Divert to number] is selected, enter the number which you wish to divert the call to, or press [Contacts] to select from an existing
number. For both options, you can set the no reply time to 5, 10, 15, 20, 25 and 30 seconds.

To deactivate this function, press [Off].

You can check if this function has been turned on/off by pressing [Check status].

4. Divert if unreachable: This setting redirects all incoming calls to another phone number if the phone ever loses registration for any

reason.

Press [Activate] to enable this function. You can choose between [Divert to voicemail] or [Divert to number].

If [Divert to voicemail] is selected, make sure the correct settings are configured per the SIM card’s service provider under [Line number].
If [Divert to number] is selected, enter the number which you wish to divert the call to, or press [Contacts] to select from an existing
number.

To deactivate this function, press [Off].

You can check if this function has been turned on/off by pressing [Check status].

5. Cancel all diverts: Press to cancel all existing call forwarding/diverts.

38



D-Link

Building Networks for People

N o o M e DN

6.3.4 Call waiting

Call waiting allows you to take a second call without disconnecting the first.
To activate call waiting, Press ><43# on standby mode to activate the service on Telkom.

Thereafter, you can [Activate], [Cancel], [Check status] on the call waiting interface.

6.3.5 Call barring

Call barring lets you stop certain types of calls being made from your phone. This feature is network independent.

Please contact your network operator for setup of this feature. Available options are:

. All Outgoing Calls: This will block your phone from making all calls (except emergency & toll-free calls).

All Received Calls: This will block your phone from receiving any calls.

Receive Calls in Roaming: This will block your phone from receiving any calls while in roaming status.
International Calls: This will block your phone from making all international calls.

Make Calls in Roaming: This will block your phone from making any calls while in roaming status.
Cancel all barring: Cancel all configured barring.

Change Password: Change the password set for call barring.

6.3.6 Hide ID

You can set the CLI of the telephone to display: [Hide ID], [Display own ID] or [Display ID by network].
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6.3.7 Call time minute reminder

Enable or disable this function. It allows you to set a time limit reminder with a warning tone during the call. You can

set the reminder at 50, 55, 60 seconds or off.

6.3.8 Auto redial

Enable or disable this function. This is a service feature that when you call and get no answer or busy tone, the

phone will automatically redial or ask if you want to redial. You may press [Cancel] when the phone is redialling.

6.3.9 Answer/Reject mode

You can enable or disable Any-Key answer function. With any-key answer, you will be able to answer the phone by

picking up the handset or by pressing any key on the phone for hands free mode.

6.3.10 Post-dialling delay

Post dialling delay is the time between the start of the call and the moment the phone of the called party starts

ringing. Available options are: Off, 1~8 seconds.
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6.4 Security

SIM security: You can complete the following functions here:

1. PIN: Set PIN lock to on or off, or modify PIN. Note that the SIM PIN number is issued by your network provider and is shown on your
Complete SIM card.

2. PIN2: You will be prompt to enter your PIN2 as you enter this option. Contact your network service provider for your PIN2 should you
wish to modify, or turn on this feature.

3. Auto lock screen: You can set the phone to lock after a certain period. Select [Time out] - Default password [1234] and choose a pre-set
time of [Off], [5s], [15s], [30s], [1min] and [5mins] = [OK]. You can change the phone lock password here to make access more secure,
select [Modify key lock password].

4. Power-on password: You can set the phone to be locked when powered on. This will make access more secure. Press [Activate] > Set
password (4-8 digits) - [OK]. To modify the password after it has been set, press [Modify] > Enter the set password - Enter new

password (4-8 digits) - Confirm new password. To deactivate this feature, press [Off] > Enter the set password.
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6.5 Profiles

In idle screen, press [Menu] - [Settings] = [5. Profiles]. Please take note that the phone only provides 4 pre-defined

modes and 3 empty profiles. You can configure the following functions here for each profile:

1. Activate: Enable the selected profile for the phone.

2. Settings: You can set the incoming call ring, message rings, volume adjustment, other alert rings for each profile.

Options available are:

1. Ring settings: Here you can set the caller ringtone and message ringtone.

2. Adjust volume: Here you can adjust the volume level for the caller ringtone, message ringtone, call volume (handset or hands free
volume), alarm & calendar ringtone and power on/off ringtone.

3. Other alert ringtone: Here you can enable/disable the ringtone for Key Tone (keypad sound), Battery low alert, Power ringtone (ringtone

when the phone is powered on/off).

6.6 Phone Info

Here you will find the version info of the phone.
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6.7 Calculator

In this menu, you can do basic calculations of addition, subtraction, multiplication and division.

Key functions in Calculator Mode:

e [Up Key]: Press once for Addition * +”

n

e [Down Key]: Press once for Subtraction * -
o [Left Key]: Press once for Multiplication “ X ”

¢ [Right Key]: Press once for Subtraction * + ”

e [Left Soft Key]: Press for operations such as Equal ( =), M+, M-, MR, MC and Clear ( C)
¢ [Right Soft Key]: Press to clear contents that have been entered

e [><]: Press to enter decimal * ® ”

e [#]: Press to enter negatives “ - ”

Note: When memory (M+) is used, the number will be stored and indicated on the screen as M:
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6.8 Alarm

e You can set up to three alarm clocks.
e Choose one pre-set alarm to edit.

e When you edit, you will have the following options to customize your alarm:

1. Time: Set the desired time for when the alarm should sound.
2. Ring: Set the desired tone to sound when the alarm goes off.
3. Repeat: Set the alarm for Once, Daily or Customize. When you select Customize, you can manually select the days when the alarm

should sound. Once the desired days have been selected, press [Save] - Done [Back].

e To disable the alarm, press [Options] = [On/off].

6.9 Operator Menu (STK)

SIM Application Toolkit (STK) is a standard of the GSM system which enables the Subscriber Identity Module (SIM) to
initiate actions which can be used for various value-added services. This function is Network Operator specific and

can vary. Please contact your Network Operator for further assistance.
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7 Frequently Asked Questions

If any problems are encountered while using the phone, please refer to below FAQs. If the problems still exit, please

contact the Network Operator.

Q. “Enter PIN code" appears on the screen.

A. Enter the PIN code of your SIM card. Please contact your Network Provider immediately if you do not know the

code.

Q. “Enter PUK code" appears on the screen.
A. Your SIM card will be locked if you enter wrong PIN code for three times. To unlock your SIM card, you have to
enter PUK code. Enter the PUK code of your SIM card. Please contact your Network Provider immediately if you do

not know the code.

Q. “Insert SIM card" appears on the screen.
A. Make sure the SIM card is correctly installed. Check if the SIM card works properly in another device where

possible. SIM card may be defective or faulty. Please contact you Network Provider for a SIM swop if faulty.
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Q. Poor sound quality, echo or noise makes communication difficult.
A. Hang-up your phone and dial again. The Network may connect the phone to a line with better communication

quality. If the problem persists, please contact you Network Provider.

Q. “Not in service area. Network failure.” is displayed.
A. Check the signal indicator. If there is no signal, you may be in the basement or network blind area in a building.
Please move to other locations to receive signal. Or potentially you are not in a coverage area. If so, please contact

your Network Provider for assistance.

Q. Standby time declines.
A. Signal at your location is weak so that the phone has to search signal for a long time. When you don’t want to
answer any calls, please power off for a time being. It is also possible that the battery has been used for a long time

and approaches its life-span. In this case, please replace the battery.

Q. Phone fails to boot.
A. Your battery is potentially not charged. Please charge your phone until the battery power is restored, then try to

power on again.
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Q. Cannot send short messages.
A. Please check the SMS address if the correct number has been set. Perhaps the recipient contact number is

invalid. Please also check if there is sufficient fund to send SMS.

Q. Cannot add entries into phonebook

A. Phonebook is full. Please delete some useless entries.

Q. Cannot charge.

A. There are three possibilities:

» Charger of your phone does not work properly. You can contact nearest service provider or dealer;
» Ambient temperature is not appropriate. Please change charging environment;

* Poor contact. Please check plug of your charger.

Q. Cannot select some functions

A. The service is not available or the location network does not support this service. Please contact your operator for

details.
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Q. Who can | contact for technical support?

A. You can call Telkom Customer Care on 081 180.

8 Technical Specifications

UMTS/HSPA+(WCDMA) Band Support!
* Bands 850/1900MHz
GSM Quad-band'
+ 850/900/1800/1900/MHz
LCD
» 240x32 dots, backlight function
Feature
* Make & Answer calls, Send & Receive SMS, Contacts
» Emergency call, Call waiting & delay & forwarding,
Calendar, Calculator
Standby Time
 Standby time: = 120 hours (Battery)
« Talk time: = 3 hours (Battery)

» Recharge time: < 8 hours (Battery)

Structure
* Size: 227 x 157 x 70mm / kg
Power adapter

» Power adapter: DC 5V / 500mA

* Battery: 3.7V / 800mA
Package Content

* Phone Unit x 1pc

* Handset Receiver x 1 pc

» Handset Cord x 1 pc

* Li + Battery x 1pc

» Power Adapter x 1pc

* Basic User Setup Guide x 1pc

* TNC Antenna x 1pc
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